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3. ITL SOFTWARE SUPPORT GUIDE 
 

3.1 Validator Manager Software 
 

Validator Manager (also called Bank Note Validator Currency Manager) is a software 
package developed by Innovative Technology Ltd to allow customers to carry out 
programming, setup and operational tasks on the NV9 USB bank note validator. 
 
3.1.1 Preparing for Installation 
 
If you do not have the Validator Manager software on CD, you can easily download it 
from the Innovative Technology website. Visit www.innovative-technology.co.uk, and 
select ‘Software Download’ from the ‘Support’ tab: 
 

 
 
Clicking this link will take you to the software download page. To download any files 
you must log in as a registered user – if you have not already registered this is a very 
quick process; just click the ‘create an account’ link and follow the on-screen 
instructions. 

http://www.innovative-technology.co.uk/
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After logging in, the download screen will change slightly: 
 

Your user name will be displayed in 
the top right hand corner of the 
screen 

 

 

The padlock icon for each file will 
change from locked to unlocked. To 
download a file, just click on the 
padlock icon opposite the file name. 

                

If you want to find more information 
about the file before you download 
it, you can click on the blue 
information icon.   

 

Enter your login 
details here, or 
create a new 
account 
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In this case, we want to download the Validator Manager software, so we click on the 
padlock icon opposite the ‘Bank Note Validator Currency Manager’ filename: 
 

 
 
 
After clicking the link, a file download dialog box will appear – choose the option to 
save the file:  
 
 

 
 
 
You can save the file anywhere that is convenient, as long as you can remember 
where it is when you want to install the software. 
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After choosing where to save the file, a file transfer dialog box will appear showing 
the progress of the file download: 
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3.1.2 BV Interface Drivers 
 
After downloading the Validator Manager software, you will also need to download the 
Banknote Validator (BV) Interface drivers – two versions are available (32 bit and 64 
bit) so choose the correct type for your operating system. Again, remember where 
you saved the file. 
 

 
 
Both files are provided in a ‘zipped’ (compressed) form – you will need to extract the 
files from the zipped file before you can install the software or driver. Any version of 
Windows from Windows 98 onwards can open zipped files; or you may want to use a 
third party software tool such as Winzip or WinRAR. 
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Extract the files to a convenient location – this might be an existing folder, or you may 
want to save them into a new folder. 
 

 
 
In this example, the BV Interface driver files are being saved into a folder called 
‘Drivers’ on the computers C: drive. 
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3.1.3 Installing the Drivers  
 
There are several ways to communicate with the NV9 USB validator, which include 
using a direct connection from computer to validator with a CN00392 validator to USB 
cable, or by using a special interface unit called a DA2. Use of the DA2 is not covered 
here – please refer to ITL Document number GA00338-2 for more information. In this 
manual we will be using the USB connection method. 
 
To use a USB connection with the NV9 USB, a USB cable with a 16 way connector on 
one end (ITL Part Number CN00392) should be used. The CN00392 cable fits into the 
16 way connector and allows high speed programming and serial communications 
when used in SSP, ccTalk and SIO modes. When using the USB connection, power 
must be supplied to the NV9 USB using the red and black power leads on the 
CN00392 cable. 
 
The connector needed to set up and interface with the NV9 USB Validator is easily 
accessible on the side of the unit: 
 

 

 

 

 
 
Interface Connector 
 

 

 

 

 

 
The NV9 USB validator must be powered up for the interface to be recognised by 
Windows. If the validator is not in the host machine, you will need to provide power 
to the 16 way interface connector first. The connection information and pin numbering 
is as follows: 
 

 
 
 
 
 
 

Pin Description 

1 Serial Data Out (Tx) 

5 Serial Data In (Rx)  

11 USB Data + 

12 USB Data - 

13 USB Power (+5V) 

15 + V 

16 0V / Ground Connection  
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Before connecting the USB cable to the computer, make sure that the CN00392 cable 
is connected to the validator and that the unit is powered up. Once you have carried 
out these steps, plug the USB cable into the computer. 
 
After connecting the USB cable, Windows 
should then detect the NV9 USB validator 
interface – a ‘Found New Hardware’ 
bubble or dialog box should appear. 
 
 
 
A ‘Found New Hardware’ wizard should then start to guide you through the installation 
process (this first screen is not always shown on some computers): 
 
 

 
 

 
 

   
Information 

Only use V2 drivers 

Please make sure that you are using the V2 drivers 
for the installation. 

 
 

Select this option 
as you already 
have the drivers 
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The next dialog box will ask you where to search for the drivers: 
 
 

 
 
 
 
 
 

Select this option as 
we have saved the 
drivers to a known 
location 

Click the ‘Browse’ 
button to find the 
driver files (in this 
example C:\Drivers) 
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Click the ‘Next’ 
button to install 
the drivers 

Uncheck this option 
to speed up the 
installation 
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You may see a warning dialog saying that the drivers have not passed Windows logo 
testing – you can ignore this warning. Just click the ‘Continue Anyway’ button. 
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Click the ‘Finish’ 
button to complete 
the installation 
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After completing the driver installation you can check that the communications port 
has been installed correctly. 
 
Open Windows Device Manager, and click on the Plus symbol (+) next to the ‘Ports’ 
entry. This will expand the list of installed communications ports. You should see an 
entry for an ‘ITL BV Serial V2’ port as shown here: 
 

 
 
The actual communications port number (in our example COM5) may vary depending 
on your particular computer configuration. 
 
Now the drivers have been correctly installed you can install the Validator Manager 
software – this is covered next. 
 



NV9 USB Manual Set – Section 3  17 

   

Copyright © Innovative Technology Ltd 2012  GA00550-2 
 

3.1.4 Installing the Validator Manager Software 
 
Installing the Validator Manager software is very straightforward. Find the Validator 
Manager zipped file you downloaded earlier, extract the installation file from the 
zipped file and double click the extracted file (it has an .msi extension) – this will start 
the installation process: 
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You can choose where you would like to install the software, or just accept the default 
location (as shown above). Clicking on the ‘Next’ button will then ask you to confirm 
the installation: 
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Once the installation is complete, you will have a new program group called ‘ITL 
Validator Manager’ in the Windows Start Menu, similar to the one shown here: 
 
 

 
 

You can run the Validator Manager software by clicking the ‘Shortcut to 
ValidatorManager.exe’ menu entry; however, before you can use the Validator 
Manager software with an NV9 USB validator you will need to make sure that you 
have installed the BV interface drivers (as described earlier). 
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3.1.5 Starting the Validator Manager Software 
 
The Validator Manager software is launched by clicking the ‘Shortcut to 
ValidatorManager.exe’ entry in the ‘ITL Validator Manager’ menu group. 
 

 
 
The initial program screen looks like this: 
 

 
 
Make sure that the NV9 USB Validator is powered up and the USB cable is connected 
before going any further. All of the program options can be accessed from the menu 
bar at the top of the screen – some specific functions can also be accessed by clicking 
the relevant icon underneath the menu bar, and the function of each icon is indicated 
by a ‘tooltip’ indicator 
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Please be aware that not all the program options are applicable to the NV9 USB, as 
the Validator Manager software is designed to work with a range of ITL Technology 
validators. 

 
Full details of all the Validator Manager software functions are detailed in the program 
help file (accessible from the ‘Help’ menu).  
 
Options: 
 
 
 
The general preferences 
for the Validator 
Manager software are 
accessible from the 
‘Tools’ menu (as 
shown). Click the 
‘Options’ entry to open a 
new dialog box:  
 
 
 
 
 

 
 
 
 
Selecting the ‘Serial Port’ tab from the ‘Options’ dialog and defining which serial port 
to use to connect to the NV9 USB validator should be one of the first things you do 
after installing the software. 
 
 

These three options are not 
used with the NV9 USB 
validator. 
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The Validator Manager will not work if the serial port is not set or is set incorrectly (if 
the serial port has not been set a dialog box will appear will appear when you run the 
program prompting you to enter or correct the port setting): 
 

 
 
 

 
 
Select the correct serial port from the list and click the ‘OK’ button to confirm the 
setting. 
 

Click this arrow and then click on the 
port you want to select as the default 
from the drop down list. 



NV9 USB Manual Set – Section 3  23 

   

Copyright © Innovative Technology Ltd 2012  GA00550-2 
 

Check Notes: 
 

 
 
 
The ‘Check Notes’ menu item provides a way to check the validator will correctly 
accept bank notes. Clicking the ‘Start-up’ button will initialise the NV9 USB validator 
and allow acceptance of bank notes. 
 

Enable or disable a 
channel by clicking the 
respective button. 

A summary of 
accepted notes by 
channel 
(denomination) is 
shown here. 

A command and response 
summary is shown here. 
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3.1.6 Preferences, Settings and Options 
 
Options: 
 
The general preferences for 
the Validator Manager 
software are accessible from 
the ‘Tools’ menu (as shown). 
Click the ‘Options’ entry to 
open a new dialog box:  
 
 
 
 
 

 
 
 
 
 
By selecting the ‘Serial Port’ tab from the ‘Options’ dialog you can define which serial 
port is being used to connect to the NV9 USB validator – click the ‘OK’ button to 
confirm the setting: 
 

 
 

Click this arrow and then click on the 
port you want to select as the default 
from the drop down list. 
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The Validator Manager software can detect the address used by the validator from the 
‘Slave Address’ tab: 
 

 
 
After clicking the ‘Set Program Address’ 
button, a dialog box will appear confirming 
the new setting - click the ‘OK’ button to 
confirm the change. 
 
 
 

   
CAUTION! 

Limited slave address 
ranges 

 

The Validator Manager software will only 
communicate with the validator if the slave address 
is set to 0, 1 or in the range 80-99. 

 
 

Click this button to allow 
the Validator Manager 
software to interrogate the 
attached validator and 
determine the currently 
set slave address. 

Click this button to cancel 
finding the slave address. 

Click this button to set the 
slave address. 
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The ‘ccTalk Key’ tab allows the user to enter a six digit security key for use when the 
validator is set for ccTalk operation. 
 

 
 
The ccTalk key is the HOST key, and is used for the ccTalk check – the validator must 
be configured to use the same key. 
 

   
CAUTION! 

Take care when changing 
ccTalk key 

 

The user should make a note of the new key and 
after any change. The default setting for the ccTalk 
security key is 123456. 

 
 
Select the ‘Language’ tab to change the preferred language for the software. You 
shouldn’t normally need to change the language setting, as this is determined 
automatically based on the Windows locale settings. You can if you wish select one of 
five specific languages (German, English, Spanish, Portuguese or Russian) if needed, 
as shown below. 
 
Click the ‘OK’ button to confirm the change – you will have to close and reopen the 
software to allow the language change to take effect. 
 
 

Enter the 6 digit key in this 
box, and then click the 
‘OK’ key to confirm. 
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The final tab on the ‘Options’ dialog is the ‘eSSP Key’ tab. By selecting this tab you 
can set a new security key to use when the validator is operating in SSP mode. 
 
 

   
CAUTION! 

Take care when changing 
eSSP key 

 

Exercise care when changing the device eSSP key. 
The user must make a note of the new key and 
change the host key to match. If the key is not 
known then device must be returned to ITL for key 
reset. 

 
 
The eSSP key is made up a string of hexadecimal characters - each part of the key 
comprises two characters, giving a key with 16 characters in total.  
 
As an example, your key may look like this: 
 
65616d636f6e7375 
 

This is the default setting and 
will not normally need changing. 
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This key would be entered eight groups of two characters per group, like this: 
 
65  61  6d  63  6f  6e  73  75 
 

 
 
After entering the new key, press the ‘OK’ button to confirm the change. 
 

Enter the new hex security 
key in these boxes, and 
then click the ‘OK’ key to 
confirm. 
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Validator Options: 
 
NV9 USB validator specific options are accessed from the ‘Set Validator Options’ item 
on the ‘Tools’ menu: 
 

 
 
As with the ‘Options’ dialog, the ‘Set Validator Options’ dialog also has several tabs: 
 

 
 
The first tab ‘Target Details’ allow you to see specific details about the validator, and 
provides a simple way of checking what version of firmware or dataset are currently 
installed: 
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There are no user-changeable settings on this tab. 
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The second tab ‘Dataset Settings’ allows you to review and modify the settings of 
each installed channel: 
 

 
 
Right clicking on a channel will open a further dialog allowing you to make specific 
changes: 
 

 
 

Consult the Validator Manager software help file for more information on how to 
change channel settings. 
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The third tab ‘ccTalk Settings’ allows you to review and modify the ccTalk settings and 
also change the security key settings: 
 

 
 

   
CAUTION! 

Take care when changing 
ccTalk key 

 

The user should make a note of the new key and 
after any change. The default setting for the ccTalk 
security key is 123456. 

 
 
The fourth tab ‘MDB Settings’ allows you to review and modify specific settings if the 
validator is being used with the MDB protocol: 
 

 
 
 

Check this box to allow 
setting of a new user key. 

Enter the new 6 digit 
user key in this box. 
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The fifth tab ‘General Options’ allows you to review and modify a variety of validator 
specific settings, including interface mode: 
 
 
 
 
 

 
 
 
 
 
 

   
WARNING! 

Security risk 

 

Disabling the Strim Function is not recommended 
because of the potential security risks. 

 
 

   
Information 

Limited SSP address 
ranges 

The Validator Manager software will only 
communicate with the validator if the SSP address is 
set to 0, 1 or in the range 80-99. 

 

Check the box next to the interface mode 
you want the validator to operate in. 

Click these boxes to enable or disable 
the Strim and Program Card Functions, 
and whether the validator will issue 
credit after a jam. 

These pulse timing settings are only 
used if the validator is set to operate 
in Pulse mode. 

Specific channels (denominations) 
can be disabled by checking the 
appropriate box or boxes. 

The options shown in this area 
will vary depending on the 
interface type selected. 

Specify the SSP address used by the 
validator in this box. 
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The final tab, ‘Update Changes’ commits all the changes to the validator configuration 
and updates the validator accordingly: 
 
 

 
 
 
 

   
Information 

Always apply changes 

Please make sure that you click the ‘Apply Changes’ 
button, otherwise none of your configuration 
changes will be applied or saved. 

 

Click this button to apply 
all the changes and 
update the validator. 

This status bar indicates 
the progress of the update 
process. 

This message indicates the 
interface type being 
applied. 



NV9 USB Manual Set – Section 3  35 

   

Copyright © Innovative Technology Ltd 2012  GA00550-2 
 

 
After applying the changes successfully, a dialog box will 
appear confirming the operation - click the ‘OK’ button to 
confirm this and close the dialog box. The validator will 
then be reset.  
 
 
 
 

   
WARNING! 

Do not power off or 
disconnect 

 

Powering off the NV9 USB or disconnecting the 
USB cable when updating settings can cause the 
validator to stop working. 
 

 
 
eSSP Options: 
 
The ‘eSSP Options’ menu item allows the user to change the fixed part of the SSP key 
and other functions. Selecting this menu option will open a dialog box like this: 
 
 
 
 
 

 
 
 
After carrying out any of the operations on this dialog, the validator will be reset. Click 
the ‘Exit’ button to close the dialog. 

 

Click this button to disable SSP 
encryption in the validator. 

 

Click this button to enable SSP 
encryption in the validator. 

 

Click this button to change the 
validator eSSP key. 

 

Enter the new eSSP 
key in these boxes. 
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3.2  Updating Firmware and Datasets 

 

   
CAUTION! 

Do not power off 

 

Powering off the NV9 USB when updating the 
firmware or dataset can cause the validator to stop 
working. 
 

 
The NV9 USB validator firmware and dataset can be updated very easily using the 
Validator Manager software. The dataset files can be downloaded from the Innovative 
Technology Ltd website: 
 

 
 
 

   
Information 

Combined data files 

The firmware and dataset files for the NV9 USB 
validator are combined into a single file, so both will 
be updated when you carry out the update. 
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After selecting the dataset, a dialog will prompt you to save or open the file: select 
the Save option 
 
  

 
 
You can then choose where to save the file – choose a location that is convenient for 
you: 
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Once the dataset file is saved, unzip the file and you can then start the process to 
update the NV9 USB validator by connecting the USB cable and starting the Validator 
Manager software as described previously.  
 
 
 
From the Validator 
Manager main screen, 
select the ‘Open a 
BV/NV200 file’ entry 
from the ‘File’ menu as 
shown here: 
 
 
 
 
 
 
 
You will then be prompted to select the dataset file you downloaded and unzipped 
earlier – select the file and click the ‘Open’ button: 
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After clicking the ‘Open’ button, a new dialog box will appear. The status bar in the 
bottom left hand corner of the dialog box will show the progress in loading the 
dataset: 
 

 
 
Once the dataset has been loaded, the file details will be shown in the status window, 
and the two buttons at the bottom of the dialog box will be active - make sure that 
you do not disconnect the power to the NV9 USB or remove the USB cable 
until the programming operation has been completed. Click the ‘Program’ 
button to start the update process: 
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During the update process, the progress of the update will be shown in the status bar 
at the bottom left of the dialog box, and the mouse cursor will change to an 
hourglass: 
 

 
 
While the update process is being carried out, the NV9 USB bezel will flash when the 
update is completed. After the update, the NV9 USB will be reset, and the dialog box 
will then look like this: 
 

 
 
After the reset is complete, the NV9 USB validator will then be ready for use with the 
new currency.  
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3.3 Tools 
 
3.3.1 Diagnostics 
 
There is a dedicated software diagnostics tool for use with the NV9 USB validator 
called ‘Bank Note Validator Diagnostics Tools’, and this software can be downloaded 
from the Innovative Technology Ltd website: 
 

 
 
When the file download dialog box appears, click the ‘Save’ button and select a 
suitable location to save the file in: 
 

 
 
Installing the Diagnostics tools software is done in the same way as the Validator 
Manager software - Find the ITLDiagnosticsTools zipped file you just downloaded, 
extract the installation file from the zipped file and double click the extracted file (it 
has an .msi extension) – this will start the installation process. 
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After installing the software, you can run the 
diagnostics software by selecting the 
‘Shortcut to ITL Diagnostics.exe’ item near 
the top of the Windows Start menu. Make 
sure that the NV9 USB Validator is powered 
up and the USB cable is connected before 
starting the program. 
 
 
 
 
 
The main screen of the diagnostics tools software looks like this:  
 

 
 
When running the software for the first time, you need to set a few options. These 
are accessed from the ‘Options’ menu: 
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By selecting the ‘Serial Port’ item 
from the ‘Options’ menu you can 
define which serial port is being 
used to connect to the NV9 USB 
validator. After selecting this 
option, a new dialog box will open 
allowing you to choose the correct 
serial port. 
 

 
 
Select the required port from the dropdown list, 
and then click the ‘OK’ button to confirm your 
selection. This will close the dialog box and allow 
you to select another option from the menu. You 
shouldn’t normally need to change the language 
setting, as this is determined by the Windows 
locale settings. You can if you wish select one of 
four specific languages if needed, as shown 
below:  
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Select the ‘Diagnostics’ item from 
the ‘Utilities’ menu to start the 
diagnostics process (you can also 
start the diagnostics by clicking 
on the left hand icon below the 
menu bar) - this will open the 
Diagnostics screen: 
 
 

 

 
 
Click the ‘Start Diagnostic’ button to start the diagnostic process. The software will 
then prompt you to insert a special piece of green diagnostics paper (ITL part number 
LB00149). Insert the paper in the same way you would with a bank note – at the end 
of the diagnostics test the paper will be ejected. 
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Diagnostics Pass: 
 
 
 
 
 

 
 
 

Sensor test results are shown in 
this window. 

Motor test results are shown in 
this window. 

A summary of the validator type and 
related information is displayed here. 

The overall test result is displayed here. 
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Diagnostics Fail: 
 
 
 
 
 

 
 
 
 
 
 
 
 
Further details on how to use the diagnostics tools and interpret the results can be 
found in the program help file. 

Motor test results are shown in 
this window – in this example all 
the motors have passed testing. 

Sensor test results are shown in this 
window – in this example, several sensors 
have failed during the diagnostics test. 

A summary of the validator type and 
related information is displayed here. 

The overall test result is displayed here. 
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3.3.2 Connections 
 
The NV9 USB Validator has a single connector that is used to allow interfacing and 
programming.  
 
 

   
Information 

Power always required 
regardless of connection 
type. 

Power is always required on pins 15 and 16 of the 
16 way connector. 

 
The connector is a 16 pin socket located on the side of the validator head. This 
connector is used to interface the NV9 USB to the host machine. The pin numbering 
of the socket is shown below, as well as an overview of the socket connections: 
 

 

 

 

 
 

Pin Description 

1 Serial Data Out (Tx) 

5 Serial Data In (Rx)  

11 USB Data + 

12 USB Data - 

13 USB Power (+5V) 

15 + V 

16 0V / Ground Connection  

 
To use a USB connection with the NV9 USB, a USB cable with a 16 way connector on 
one end (ITL Part Number CN00392) should be used. The CN00392 cable fits into the 
16 way connector and allows high speed programming and serial communications 
when used in SSP, ccTalk and SIO modes.  

Interface Socket 
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When using the USB connection, power must be supplied to the NV9 USB using the 
CN00392 cable. 
 
The socket connections for the natively supported protocols are shown in the tables 
below, as is a summary of the interface units needed for other types of operation: 
 
 

 

   
WARNING! 

Risk of unit damage 

Do not make any connections to the interface socket 
pins marked ‘Do not connect’ – making connections 
to these pins could cause severe damage to the unit. 

 
 
NV9 USB SSP Interface: 
 
 

Pin Name Type Description 

1 Vend 1 Output Serial data out (Tx) 

2 

Factory use only Do not connect 3 

4 

5 Inhibit 1 Input Serial data in (Rx) 

6 

Factory use only Do not connect 

7 

8 

9 

10 

11 USB D+ Data USB Data + 

12 USB D- Data USB Data - 

13 USB Vcc Power USB +V (+5V) 

14 Factory use only Do not connect 

15 V In Power +V 

16 GND Ground GND 
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NV9 USB ccTalk Interface: 
 
 

Pin Name Type Description 

1 Vend 1 Output 
Serial data – must also be 
connected to pin 5 

2 

Factory use only Do not connect 3 

4 

5 Inhibit 1 Input 
Serial data – must also be 
connected to pin 1 

6 

Factory use only Do not connect 

7 

8 

9 

10 

11 USB D+ Data USB Data + 

12 USB D- Data USB Data - 

13 USB Vcc Power USB +V (+5V) 

14 Factory use only Do not connect 

15 V In Power +V 

16 GND Ground GND 
 

 
 
NV9 USB SIO Interface: 
 
 

Pin Name Type Description 

1 Vend 1 Output Serial data 

2 

Factory use only Do not connect 3 

4 

5 Inhibit 1 Input Serial data 

6 

Factory use only Do not connect 

7 

8 

9 

10 

11 USB D+ Data USB Data + 

12 USB D- Data USB Data - 

13 USB Vcc Power USB +V (+5V) 

14 Factory use only Do not connect 

15 V In Power +V 

16 GND Ground GND 
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NV9 USB Pulse Interface: 
 
 

Pin Name Type Description 

1 Vend 1 Output Credit pulse stream output 

2 

Factory use only Do not connect 3 

4 

5 Inhibit 1 Input 
Inhibit Channel 1 by holding this 
pin HIGH 

6 Inhibit 2 Input 
Inhibit Channel 2 by holding this 
pin HIGH 

7 Inhibit 3 Input 
Inhibit Channel 3 by holding this 
pin HIGH 

8 Inhibit 4 Input 
Inhibit Channel 4 by holding this 
pin HIGH 

9 Busy Output 
Busy signal – output is pulled 
low when the validator is busy 

10 Escrow Input 
Enable Escrow function by 
holding this pin LOW 

11 

Factory use only Do not connect 
12 

13 

14 

15 V In Power +V 

16 GND Ground GND 

 
 
When operating in Pulse mode the NV9 USB outputs a number of pulses on Vend 1. 
The number of pulses for each channel is different and set to default values within the 
dataset. The number of pulses and the pulse duration can be modified using the Bank 
Note Validator Currency Manager Software, and a maximum of 16 channels can be 
used. 
 
  
NV9 USB Multi Drop Bus (MDB) Interface: 
 
MDB is a serial bus interface commonly used in electrically controlled vending 
machines. This is a 9600 Baud Master – Slave system where the NV9 USB validator is 
a slave to master controller. 
 
To use the NV9 USB with MDB protocol, an IF5 external interface is required. The IF5 
regulates the power supply and opto-isolates the communication lines. The NV9 USB 
validator supports the MDB Protocol Version 1, Level 1. 
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NV9 USB Parallel Interface: 
 
 

Pin Name Type Description 

1 Vend 1 Output 
Channel 1 credit, 100ms active 
low pulse 

2 Vend 2 Output 
Channel 2 credit, 100ms active 
low pulse 

3 Vend 3 Output 
Channel 3 credit, 100ms active 
low pulse 

4 Vend 4 Output 
Channel 4 credit, 100ms active 
low pulse 

5 Inhibit 1 Input 
Inhibit Channel 1 by holding this 
pin HIGH 

6 Inhibit 2 Input 
Inhibit Channel 2 by holding this 
pin HIGH 

7 Inhibit 3 Input 
Inhibit Channel 3 by holding this 
pin HIGH 

8 Inhibit 4 Input 
Inhibit Channel 4 by holding this 
pin HIGH 

9 Busy Output 
Busy signal – output is pulled 
low when the validator is busy 

10 Escrow Input 
Enable Escrow function by 
holding this pin LOW 

11 

Factory use only Do not connect 
12 

13 

14 

15 V In Power +V 

16 GND Ground GND 

 
 
When operating in Parallel mode the NV9 USB will issue a 100ms active LOW pulse on 
the relevant vend line, and a maximum of 4 channels can be used. There is also the 
option to use a binary output where the NV9 USB will output a binary pattern on vend 
lines 1 – 4. Binary mode can be set as an option using a configuration card or with the 
Bank Note Validator Currency Manager Software. 
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3.4 Frequently Asked Questions 
 
a. Why are there no DIP switches on the unit? 
 

 The NV9 USB has no dipswitches. Configuring the unit is carried out using a 
configuration button mounted on top of the unit – see Section 1, subsection 1.3 
of this manual set for more information. 

 
b. Are 64 bit drivers available? 
 

 Both 32 and 64 bit drivers can be downloaded from the ‘Support’ section of the 
ITL website – please make sure that you are using the correct type of driver for 
your Operating System. 

 

c. Some or all notes are not accepted 
  

 Check that no inhibits are set in the Validator Manager software (see 
subsection 3.1 of this manual). If the problem persists, contact ITL Support for 
further assistance. 
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